Configuration d'AnyConnect Remote Access
VPN sur FTD

Table des matiéres

Introduction

Conditions préalables

Exigences

Composants utilisés

Informations générales

Configuration

1. Conditions préalables

a) Importer le certificat SSL

c) Créer un pool d'adresses pour les utilisateurs VPN
d) Créer un profil XML

e) Télécharger des images AnyConnect

2. Assistant Acceés a distance

Connexion

Limites

Considérations de sécurité

a) Activer uRPF

b) Activez |'option de connexion sysopt permit-vpn
Informations connexes

Introduction

Ce document décrit une configuration pour AnyConnect Remote Access VPN sur FTD.

Conditions préalables

Exigences
Cisco vous recommande de prendre connaissance des rubriques suivantes :
- Connaissances de base en VPN, TLS et IKEv2

. Connaissances de base en authentification, autorisation et comptabilité (AAA) et RADIUS
- Expérience avec Firepower Management Center

Composants utilisés

Les informations contenues dans ce document sont basées sur les versions de matériel et de
logiciel suivantes :

. Cisco FTD 7.2.0



- Cisco FMC 7.2.1
- AnyConnect 4.10

The information in this document was created from the devices in a specific lab environment. All of
the devices used in this document started with a cleared (default) configuration. Si votre réseau
est en ligne, assurez-vous de bien comprendre 'incidence possible des commandes.

Informations générales

Ce document fournit un exemple de configuration pour Firepower Threat Defense (FTD) version
7.2.0 et ultérieure, qui permet au VPN d'acces a distance d'utiliser Transport Layer Security (TLS)
et Internet Key Exchange version 2 (IKEv2). En tant que client, Cisco AnyConnect peut étre utilisée,
qui est pris en charge sur plusieurs plates-formes.

Configuration

1. Conditions préalables
Afin de passer par I'assistant d'accés a distance dans Firepower Management Center :

- Créez un certificat utilisé pour 'authentification du serveur.

- Configurez le serveur RADIUS ou LDAP pour l'authentification des utilisateurs.
- Créez un pool d'adresses pour les utilisateurs VPN.

- Téléchargez des images AnyConnect pour différentes plates-formes.

a) Importer le certificat SSL

Les certificats sont essentiels lorsque vous configurez AnyConnect. Le certificat doit avoir une
extension Subject Alternative Name avec un nom DNS et/ou une adresse IP pour éviter des
erreurs dans les navigateurs Web.

Remarque : seuls les utilisateurs Cisco enregistrés ont accés aux outils internes et aux
informations de bogue.

L'inscription manuelle des certificats comporte des limites :
- Sur FTD, vous avez besoin du certificat CA avant de générer le CSR.

- Si le CSR est généré en externe, la méthode manuelle échoue, une autre méthode doit étre
utilisée (PKCS12).

Il existe plusieurs méthodes pour obtenir un certificat sur I'appareil FTD, mais la plus s(re et la
plus simple est de créer une demande de signature de certificat (CSR), de la signer avec une
autorité de certification (CA), puis d'importer le certificat émis pour la clé publique, qui était dans
CSR. Voici comment procéder :

- Aller a Objects > Object Management > PKI > Cert Enrollment , Cliquez sur Ajouter une inscription de
certificat.



Add Cert Enroliment (7]

Name*
vpntestbbed.cisco.com
Description
|
CA Information Certificate Parameters Key Revocation

Enrollment Type: | Manual v
[ ] CA Only
Check this option if you do not require an identity certificate fo be created
from this CA
CA Certificate: Ep':“_ Iangreno .. ST2xar
YfPCilB7g

BMAV7Gzdc4VspS6ljirAhbiiaw
dBiQIQmsBeFz9JkF4..b3I8Bo
GN+gMa56Y
lt8unaZgY4l20//on88r5IWJIm

Validation Usage: IPsec Client SSL Client [ | SSL Server
| | Skip Check for CA flag in basic constraints of the CA Certificate

|| Allow Overrides

| Cancel | Save

- Sélectionner Enroliment Type €t collez le certificat de I'autorité de certification (le certificat utilisé
pour signer le CSR).

- Accédez ensuite au deuxiéme onglet et sélectionnez custom FQDN et remplissez tous les
champs nécessaires, par exemple :



Add Cert Enroliment Q

Name*
vpntestbbed.cisco.com
Description
CA Information Certificate Parameters Key Revocation

Include FQDN: Use Device Hostname as FODN

Include Device's IP Address: 10.88.243.123

Common Mame (CN): vpntestbed.cisco.com

Organization Unit (OU): TAC

Organization (0): | Mexico

Locality (L): | MX

State (ST): CDMX

Country Code (C): | MX

Email (E): I tac@cisco.com

Include Device's Serial Number | |

|| Allow Overrides

Cancel Save

- Dans le troisieme onglet, sélectionnez Key Type, choisissez le nom et la taille. Pour RSA, 2048
bits est minimum.

- Cliquez sur Enregistrer et accédez a Devices > Certificates > Add > New Certificate.

- Sélectionnez ensuite Device, et sous cert Enroliment S€lectionnez le point de confiance que vous
venez de créer, puis cliquez sur Add:



Add New Certificate (7]

Add a new certificate to the device using cert enrollment object which is used to
generate CA and identify certificate.
Device®:

FTD v

Cert Enrollment®:

l vpntestbed.cisco.com| v ‘ +

Cert Enrollment Details:

MName: vpntestbed.cisco.com

- Plus tard, en regard du nom du point de confiance, cliquez sur le bouton "?5" , PUIS Yes, puis
copiez CSR a CA et signez-le. Les attributs du certificat doivent étre identiques a ceux d'un
serveur HTTPS normal.

- Apres avoir recu le certificat de CA au format base64, sélectionnez-le sur le disque et cliquez
sur import. Lorsque cette opération réussit, vous voyez :

=D -

VpnbesEhed.clco.com Ginbal Selt-Signed [-T=NREN ] P C

b) Configurer le serveur RADIUS

. Aller a objects > Object Management > RADIUS Server Group > Add RADIUS Server Group.
- Remplissez le nom et ajoutez |'adresse IP avec le secret partagé, cliquez sur save:



Edit RADIUS Server

IP Address/Hostname:*

192.168.20.7
Configure DNS at Threat Defense Platform Settings to resolve hostname
Authentication Port:* (1-65535)

1812
Key:*

Confirm Key:*

—
—a
I
an
(9 |
(]
Cad
(9 |

Accounting Port:
1813

Timeout: (1-300) Seconds
10

Connect using:
(® Routing () Specific Interface @

Default: Management/Diagnostic k

Redirect ACL:

| Cancel | Save

- Aprés cela, vous voyez le serveur sur la liste :
Mame Value

RadiusServer 1 Server

c¢) Créer un pool d'adresses pour les utilisateurs VPN



- Aller a objects > Object Management > Address Pools > Add IPv4 Pools.
- Mettez le nom et la plage, le masque n'est pas nécessaire :

Name*

I vpn_pool ‘

IPv4 Address Range*
\ 10.72.1.1-10.72.1.150 \

Mask
‘ Specify a netmask in X.X.X.X format ‘

Description

Allow Overrides

. Configure device overrides in the address pool object to
avoid IP address conflicts in case of object is shared across
multiple devices

»  Override (0)

d) Créer un profil XML

. Téléchargez I'Editeur de profil depuis le site Cisco et ouvrez-le.
- Aller a server List > Add...
- Placez le nom d'affichage et le FQDN. Vous voyez des entrées dans la liste des serveurs :

[ AnyConnect Profile Editor - VPN — O *
File Help
4 -
VPN | Server List

@ Preferences (Part 1)
< Preferences (Part 2)
Backup Servers
# Certificate Pinni
_Ln C:;tiﬁi:te h"::gigng Hostname Host Address User Group Backup Server List  SCEP Maobile Settings Certificate Pins

Certificate Enrollment

Profile: C:AUsers\calo\Documents\Anyconnect_profile.xml

VPM(S5L) vpntestbed.dsco.... - Inherited —

Mobile Policy VPN(IPSEC) vpntestbed, cisco. ... - Inherited —
- |afl Server List
Mote: it is highly recommended that at least one server be defined in a profile. Add... Delete

. Cliquer oket File > save as...



e) Télécharger des images AnyConnect

- Téléchargez les images du package depuis le site Cisco.
- Aller a objects > Object Management > VPN > AnyConnect File > Add AnyConnect File.
- Tapez le nom et sélectionnez le fichier PKG sur le disque, puis cliquez sur Save:

Edit AnyConnect File (7]

Mame:*

| Wnyconnectmac4.10 |

File Name:*

| anyconnect-macos-4.10.06079-webdef | | Browse..
File Type:*

| AnyConnect Client Image v |
Description:

Cancel |

- Ajoutez d'autres packages en fonction de vos propres besoins.

2. Assistant Accés a distance

- Aller a Devices > VPN > Remote Access > Add a new configuration.
- Nommez le profil et sélectionnez le périphérique FTD :



Targeted Devices and Protocols

This wizard will guide you through the required minimal steps to configure the Remote
Access VPN policy with a new user-defined connection profile.

Mame:*

| Anyconnect_RA |

Description:

VPN Protocols:

SSL
IPsec-IKEv2

Targeted Devices:

Available Devices Selected Devices

| Q_ Search | FTD

FTD

- Dans l'étape Profil de connexion, tapez Connection Profile Name, Sélectionnez |'option Authentication
Server et Address Pools que vous avez créé précédemment :



Connection Profile:

Connection Profiles specify the tunnel group policies for a VPN connection. These policies pertain to creating the
tunnel itself, how AAA is accomplished and how addresses are assigned. They also include user attributes, which
are defined in group policies.

Connection Profile Name:* | Anyconnect_RA

I @ This name is configured as a connection alias, it can be used to connect to the VPN gateway

Authentication, Authorization & Accounting (AAA):

Specify the method of authentication (AAA, certificates or both), and the AAA servers that will be used for VPN
connections.

Authentication Method: [ AAA Only v l

RadiusServer v ] -+
(LOCAL or Realm or RADIUS)
[ Fallback to LOCAL Authentication

Authentication Server:*

Authorization Server: | Use same authentication server | +
(Realm or RADIUS)

Accounting Server: | v | -
(RADIUS)

Client Address Assignment:

Client IP address can be assigned from AAA server, DHCP server and IP address pools. When multiple options are
selected, IP address assignment is tried in the order of AAA server, DHCP server and IP address pool.

] Use AAA Server (Realm or RADIUS only) @

[ ] Use DHCP Servers
Use IP Address Pools

N

IPvd Address Pools: l vpn_pool J
|

IPv6 Address Pools: I

Group Policy:

A group policy is a collection of user-oriented session attributes which are assigned to client when a VPN
connection is established. Select or create a Group Policy object.

Group Policy:* DfitGrpPolicy v | +

Edit Group Policy

- Cliquez sur Edit Group Policy et dans l'onglet AnyConnect, sélectionnez client profile, puis cliquez
Sur Save:



Edit Group Policy (7]

Name:*
DfitGrpPolicy

Description:

General AnyConnect Advanced

Profile

AnyConnect profiles contains settings for the VPN client functionality and
Management Profile = optional features. Firewall Threat Defense deploys the profiles during

AnyConnect client connection.
Client Modules

SSL Settings Client Profile:
Anyconnect_profile A | +

Connection Settings

Custom Attributes Standalone profile editor can be used to create a new or modify existing
AnyConnect profile. You can download the profile editor from Cisco Software
Download Center.

- Sur la page suivante, sélectionnez Images AnyConnect et cliquez sur Next.
AnyConnect Client Image

The VPN gateway can automatically download the latest AnyConnect package to the client device when the VPN
connection is initiated. Minimize connection setup time by choosing the appropriate OS for the selected package.

Download AnyConnect Client packages from Cisco Software Download Center.

Show Re-order buttons 4

AnyConnect File Object Name AnyConnect Client Package Name Operating System

Anyconnectmac4.10 anyconnect-macos-4.10.06079-webdeploy... Mac OS v ‘

. Dans I'écran suivant, sélectionnez Network Interface and Device Certificates:



Network Interface for Incoming VPN Access

Select or create an Interface Group or a Security Zone that contains the network interfaces users
will access for VPN connections.

Interface group/Security Zone:* | Outsied v | +

Enable DTLS on member interfaces

A All the devices must have interfaces as part of the Interface Group/Security Zone selected.

Device Certificates

Device certificate (also called Identity certificate) identifies the VPN gateway to the remote access
clients. Select a certificate which is used to authenticate the VPN gateway.

Certificate Enrollment:* vpntestbed.cisco.com v | +

Access Control for VPN Traffic

All decrypted traffic in the VPN tunnel is subjected to the Access Control Policy by default. Select
this option to bypass decrypted traffic from the Access Control Policy.

Bypass Access Control policy for decrypted traffic (sysopt permit-vpn)
This option bypasses the Access Control Policy inspection, but VPN filter ACL and
authorization ACL downloaded from AAA server are still applied to VPN traffic.

- Lorsque tout est correctement configuré, vous pouvez cliquer sur Finish et ensuite Deploy:



° §—9 © 1.
= GNP
Remote Outside VPN i

AnyConnect
User Client Device

%Q
/o

AAA
Remote Access VPN Policy Configuration

Additional Configuration Requirements

Firepower Management Center will configure an RA VPN Policy with the following settings After the wizard completes, the following

Name: Anyconnect_RA configuration needs to be completed for VPN to
Device Targets: FTD work on all device targets.
Connection Profile: Anyconnect_RA ®)AGcess Contml Bl lpdats
Connection Alias: Anyconnect_RA
AAA: An Access Control rule must be defined to allow
) VPN traffic on all targeted devices.
Authentication Method:  AAA Only )
Authentication Server:  RadiusServer (RADIUS) © NAT Exemption
Authorization Server: RadiusServer (RADIUS) If NAT is enabled on the targeted devices, you

: ) must define a NAT Policy to exempt VPN traffic.
Accounting Server; =

Address Assignment: © DNS Configuration
Address from AAA: -
DHCP Servers: -
Address Pools (IPv4): vpn_pool
Address Pools (IPv6): - © Port Configuration

To resolve hostname specified in AAA Servers
or CA Servers, configure DNS using FlexConfig
Policy on the targeted devices.

Group Policy:
AnyConnect Images:
Interface Objects:

Device Certificates:

DMGrpPolicy
Anyconnectmac4.10
Qutsied

vpntestbed.cisco.com

SSL will be enabled on port 443.
IPsec-IKEv2 uses port 500 and Client Services
will be enabled on port 443 for Anyconnect
image download.NAT-Traversal will be enabled
by default and will use port 4500.

Please ensure that these ports are not used in
NAT Policy or other services before deploying
the configuration.
Device Identity Certificate Enrollment
A Network Interface Configuration
Certificate enrollment object 'vpntestbed.cisco.com’ is not installed on one or more
targeted devices. Certificate installation will be initiated on the targeted devices on
finishing the wizard. Go to the Certificates page to check the status of the installation.

Make sure to add interface from targeted
devices to SecurityZone object 'Outsied’

- Cette opération copie l'intégralité de la configuration avec les certificats et les packages
AnyConnect vers I'appliance FTD.

Connexion

Pour vous connecter a FTD, vous devez ouvrir un navigateur, tapez le nom DNS ou I'adresse IP
qui pointe vers l'interface externe. Vous vous connectez ensuite avec les informations
d'identification stockées sur le serveur RADIUS et suivez les instructions a I'écran. Une fois
AnyConnect installé, vous devez placer la méme adresse dans la fenétre AnyConnect et cliquer
Sur Connect.

Limites
Actuellement non pris en charge sur FTD, mais disponible sur ASA :
- La sélection d'interface dans le serveur RADIUS n'est pas prise en charge sur Firepower
Threat Defense6.2.3 ou les versions antérieures. L'option d'interface est ignorée pendant le

déploiement.
- Un serveur RADIUS activé pour l'autorisation dynamique nécessite Firepower Threat



Defense6.3 ou version ultérieure pour que l'autorisation dynamique fonctionne.

- Le VPN FTDposture ne prend pas en charge la modification de stratégie de groupe via
I'autorisation dynamique ou la modification d'autorisation RADIUS (CoA).

- Personnalisation AnyConnect (amélioration : ID de bogue Cisco CSCvq87631)

- scripts AnyConnect

- Localisation AnyConnect

- Intégration WSA

- Carte de cryptage dynamique IKEv2 simultanée pour les VPN RA et L2L (amélioration : ID de
bogue Cisco CSCvr52047)

- Modules AnyConnect (NAM, Hostscan, AMP Enabler, SBL, Umbrella, Web Security, etc.) -
DART est installé par défaut (améliorations pour AMP Enabler et Umbrella : ID de bogue
Cisco CSCvs03562 et ID de bogue Cisco CSCvs06642).

- TACACS, Kerberos (authentification KCD et RSA SDI)

- Proxy du navigateur

Considérations de sécurité

Par défaut, le sysopt connection permit-vpnest désactivée. Cela signifie que vous devez autoriser le trafic
provenant du pool d'adresses sur l'interface externe via la politique de contrdéle d'acces. Bien que

la régle de préfiltrage ou de contrdle d'accés soit ajoutée pour autoriser uniquement le trafic VPN,
si le trafic en texte clair correspond aux critéres de la regle, il est autorisé par erreur.

Il y a deux approches a ce probleme. Premiérement, I'option recommandée par le TAC est
d'activer I'anti-usurpation (sur ASA, il était connu sous le nom de Unicast Reverse Path
Forwarding - uRPF) pour l'interface externe, et deuxiemement, est d'activer sysopt connection permit-
vpn pour contourner complétement l'inspection Snort. La premiére option permet une inspection
normale du trafic qui va vers et depuis les utilisateurs VPN.

a) Activer uRPF

- Créez une route Null pour le réseau utilisé pour les utilisateurs d'acces a distance, défini dans

la section C. Accédez a Devices > Device Management > Edit > Routing > Static Route €t sélectionnez Add
route


https://cdetsng.cisco.com/summary/#/defect/CSCvq87631
https://cdetsng.cisco.com/summary/#/defect/CSCvr52047
https://cdetsng.cisco.com/summary/#/defect/CSCvs03562
https://cdetsng.cisco.com/summary/#/defect/CSCvs06642

Add Static Route Configuration 7

Type: @ IPvd () IPV6
Interface*
\ Nullo v \

(Interface starting with this icon [ signifies it is available for route leak)

Available Network . Selected Network

Q, Search ‘ Add ‘ objvpnusers ™
any-ipvd
FMC
GW

IPvd-Benchmark-Tests
IPvd-Link-Local
IPvd-Multicast

Gateway*

Metric:
1

(1 -254)

Tunneled: [ | (Used only for default Route)

Route Tracking:

- Activez ensuite uRPF sur l'interface ou se terminent les connexions VPN. Pour le trouver,
accédez a Devices > Device Management > Edit > Interfaces > Edit > Advanced > Security Configuration > Enable

Anti Spoofing.



Edit Physical Interface

General IPwd IPv6 Path Monitoring Hardware Configuration

Information ARP Security Configuration

Enable Anti Spoofing:
Allow Full Fragment Reassembly:

Override Default Fragment Setting:

Advanced

Manager Access

‘ Cancel |m

Lorsqu’un utilisateur est connecté, la route 32 bits est installée pour cet utilisateur dans la table de
routage. Effacer le trafic texte provenant des autres adresses IP inutilisées du pool est abandonné
par URFP. Pour afficher une description de Anti-Spoofingréférez-vous a Définir les parameétres de

configuration de sécurité sur Firepower Threat Defense.

b) Activer sysopt connection permit-vpn Option

- Si vous disposez de la version 6.2.3 ou d'une version ultérieure, vous pouvez le faire avec
I'Assistant ou sous Devices > VPN > Remote Access > VPN Profile > Access Interfaces.

Access Control for VPN Traffic

Bypass Access Control policy for decrypted traffic (sysopt permit-vpn)

e

-'ﬁ

o

f_,
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¥¥
bypasses the inspection, bt

o

ALl server are still -\.-"'_-Il-\.-'“"l_l to VPN trafiic.

ted traffic is subjected to Access Control Policy by default.

! FR 5 | Fr
t VPN Filter ACL and authorization ACL downloaded from

o e
r'||' Onon

- Pour les versions antérieures a la version 6.2.3, accédez a Objects > Object Management > FlexConfig >

Text Object > Add Text Object.

- Créez une variable d'objet texte, par exemple : vpnSysVar une entrée unique avec une valeur

sysopt.

- Aller a objects> Object Management > FlexConfig > FlexConfig Object > Add FlexConfig Object.

. Créez le Flexconfig objet avec CLI connection permit-vpn.

- Insére la variable d'objet texte dans le FlexConfig au niveau de l'interface CLI avec $vpnSysvar

connection permit-vpn. Cliquer Save:


/content/en/us/td/docs/security/firepower/622/configuration/guide/fpmc-config-guide-v622/interfaces_for_firepower_threat_defense.html?bookSearch=true#task_34BB9AC8E91946AB847C65FB79D67A5F
/content/en/us/td/docs/security/firepower/622/configuration/guide/fpmc-config-guide-v622/interfaces_for_firepower_threat_defense.html?bookSearch=true#task_34BB9AC8E91946AB847C65FB79D67A5F

Insert Text Object Variable

Variable Name: | wpnSysvar
Description:

Available Objects & Selected Object

[ 4, Search [T vpnSysvar

S ———

[T tepMssBytes
[T tepMssMinimum
[T threat_cetection_statistics

[T vadan_wve_only

[T vdtan_Port_and_Nve
[T wtan_wni

[T weepPassword

- Appliquez le FlexConfigobjet en tant que Append et sélectionnez le déploiement a Everytime:

Edit FlexConfig Object ? %
Name: | connection_permit-vpn
Description:

Oumsern~ | E | Deploymert: Type:
SvpnSysVar connection permit-vpn
Variables E]
vpnSysvar SINGLE sysopt FREEFORM:vpn.. false

[ Save J[ Cancel J

- Aller abevices > FlexConfig et modifiez la stratégie actuelle ou créez-en une nouvelle avec New
Policy s'affiche.

- Ajoutez uniquement le fichier créé FlexConfig, cliquez sur save.
- Déployer la configuration pour provisionnersysopt connection permit-vpnsur le périphérique.

Aprés cela, cependant, vous ne pouvez pas utiliser la stratégie de contrdle d'accés pour inspecter
le trafic provenant des utilisateurs. Vous pouvez toujours utiliser un filtre VPN ou une liste de
contrdle d'accés téléchargeable pour filtrer le trafic utilisateur.



Si vous voyez des paquets abandonnés avec Snort provenant des utilisateurs VPN, contactez le
TAC et référencez I'ID de bogue Cisco CSCvg91399.

Informations connexes

- Assistance technique et téléchargements Cisco



https://cdetsng.cisco.com/summary/#/defect/CSCvg91399
https://www.cisco.com/c/fr_ca/support/index.html?referring_site=bodynav

A propos de cette traduction
Cisco a traduit ce document en traduction automatisée vérifiée par une personne dans le

cadre d’un service mondial permettant a nos utilisateurs d’obtenir le contenu d’assistance
dans leur propre langue.

Il convient cependant de noter que méme la meilleure traduction automatisée ne sera pas
aussi précise que celle fournie par un traducteur professionnel.



